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Chapter 1. Introduction

The Infoprint Submit Express program product lets you create job tickets for a
customer’s print job, send the print jobs to the selected printer, and track the print
jobs. A job ticket describes a print job. It includes general information such as the
name of the job, the job ID, and the nhumber of copies you want to print. It also
includes a list of the files you want included in the print job and instructions for
printing each piece of the job. A job ticket also includes print status information
received from the server while the job is printing.

Note: The Infoprint Submit Express is replacing the Infoprint Submit for Windows
and Infoprint Submit for Macintosh clients.

Who should read this publication

This publication is for the user who installs, configures, and uses Submit Express
on a Windows or Macintosh workstation. Although you can use this publication
for general guidance in using Submit Express, you should use the online Help to
find more detailed instructions.

Most recent information

This document is available on the appropriate Print-on-Demand Feature CD-ROM.

For the most recent information about Infoprint Manager, go to the IBM Printing
Systems Web site at http://www.ibm.com/printers and click on Software, click on
pSeries (AIX) or xSeries (Windows or OS/2), scroll down to the appropriate
Infoprint Manager, and click on Learn More.

The Infoprint publication library

For the most current information, see the IBM Printing Systems website at
http://www.ibm.com/printers.

Infoprint Manager common publication library

These publications are common to both Infoprint Manager for AlX and Infoprint
Manager for Windows:

* IBM Infoprint Manager: Update Guide for PTF U483536 and PTF UR54088,
S544-5895. This publication contains information describing fixes and product
enhancements available with these service updates for both Infoprint Manager
for AIX Version 4 Release 1 and Infoprint Manager for Windows Version 2
Release 1. These service updates become available to customers in December
2003. Earlier versions of some of this information have been published
previously in the current product library.

* Infoprint Manager: SAP R/3 Planning and Configuration Guide, S544-5902. For print
administrators who need to create and configure both the SAP R/3 environment.
IBM recommends that users possess a detailed knowledge of a SAP R/3
environment, as well as administering and maintaining either AIX or Windows
operating systems. This publication describes how a business enterprise that
uses SAP R/3 can use either Infoprint Manager for AlX or Infoprint Manager for
Windows to manage its print environment.

© Copyright IBM Corp. 2002, 2004 1
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IBM Infoprint Manager: Reference, S544-5475. For print administrators, operators,
and application programmers with the need to perform command-line functions.
This publication describes the commands, utilities, transforms, attributes, and
attribute values associated with Infoprint.

Infoprint Manager for AIX publication library

Infoprint Manager for AIX includes publications in PDF format on a CD-ROM
supplied with the product. You can download PDF versions of these publications
or order printed copies of these publications from IBM at the following website:

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi?CTY=US

Notes:
1. There is a fee for the printed manuals.
2. You can use the form number specified for a publication to download a PDF

version or order a printed version.

The publications for Infoprint Manager for AlIX are:

IBM Infoprint Manager for AIX: Installation Instructions, G544-5891. This
publication provides updated migration and installation information from the
instructions available in the IBM Infoprint Manager for AIX: Getting Started
manual.

IBM Infoprint Manager for AIX: Introduction and Planning Guide, G544-5833. This
publication gives an overview of Infoprint Manager for AlX, introduces its
concepts, and helps you prepare to use it. It addresses migration from previous
versions of the product. Finally, this publication explains the differences between
the AIX and Windows versions of Infoprint.

IBM Infoprint Manager for AIX: Getting Started, G544-5817. This publication helps
you install and configure IBM Infoprint Manager for AlX. It focuses primarily on
server and client system software configuration.

Guidelines for Installing Infoprint Manager for AIX 4.1 in an HACMP Configuration,
G544-5818. This publication helps you install and configure HACMP with IBM
Infoprint Manager for AlX. It also tells you how to use HACMP with IBM
Infoprint Manager for AIX.

IBM Infoprint Manager for AIX: Configuring and Using Infoprint Fax, G544-5915.
This publication describes the primary tasks necessary for installing, configuring,
and using the Infoprint Fax feature to both send and receive faxes from an
Infoprint Manager for AIX server.

IBM Infoprint Manager for AIX: Impositioning Assist, G544-5910. This publication
describes how commercial print shops can use Infoprint Manager for AlX to
make frequent layout changes to sighature-based documents with relatively
static content. As a prerequisite, this solution requires the Infoprint Manager for
AIX Print-On-Demand feature, an IBM Infoprint 4100 Advanced Function
Printing System, and a third-party impositioning product, such as ScenicSoft
Preps.

IBM Infoprint Manager for AIX: Procedures, G544-5815. This publication describes
the primary tasks necessary for setting up an Infoprint environment, submitting
print jobs, scheduling jobs, and managing the print environment.

PSF Direct Network Configuration Guide for System/370, S544-5486. For system
administrators or network specialists responsible for configuring a system for
Print Services Facility (PSF) Direct. PSF Direct is a function of IBM Infoprint
Manager for AlIX that allows a PSF program (PSF for z/OS, PSF/390, PSF/400,
PSF/MVS, PSF/VM, or PSF/VSE) to print remotely, using the SNA LU 6.2
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protocol, on printers supported by Infoprint. The PSF program sends the print
data stream directly to the Infoprint printer.

IBM PSF for AIX: AFP Upload Configuration Guide Using SNA Server/6000,
S544-5422. For system administrators, this publication describes how to
configure AFP Upload on both AIX (client) and MVS (server) to send files to the
JES spool on the MVS server, using a SNA LU 6.2 protocol.

IBM PSF for AIX: AFP Upload Configuration Guide Using TCP/IP, S544-5423. For
system administrators, this publication describes how to configure AFP Upload
on both AIX (client) and MVS (server) to send files to the JES spool on the MVS
server, using a TCP/IP protocol.

Infoprint Manager for Windows publication library
Infoprint Manager for Windows includes publications in PDF format on a
CD-ROM supplied with the product. You can download PDF versions of these
publications or order printed copies of these publications from IBM at the
following website:

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi?CTY=US

Notes:

1. There is a fee for the printed manuals.
2. You can use the form number specified for a publication to download a PDF

version or order a printed version.

The publications for Infoprint Manager for Windows are:

IBM Infoprint Manager for Windows: Introduction and Planning Guide, G544-5716.
This publication gives an overview of Infoprint Manager for Windows,
introduces its concepts, and helps you prepare to use it. It describes features of
this product and compares its functions to those of IBM Print Services Facility
for OS/2 (PSF for OS/2). It addresses migration from PSF for OS/2 at a high
level. Finally, this publication explains the differences between the AIX and
Windows versions of Infoprint.

IBM Infoprint Manager for Windows: Getting Started, G544-5717. This publication
helps you install and configure Infoprint Manager for Windows. It focuses
primarily on server and client system software configuration, but it also includes
information for the IBM 4159 Model 001 S/390 Parallel Channel Emulator Card.
IBM Infoprint Manager for Windows: Procedures, G544-5814. This publication
contains all the Infoprint Manager for Windows procedures.

The following publications for Infoprint Manager for Windows do not have a form
number and must be obtained from the Web at www.ibm.com/printers/ipmwinlib:

Infoprint Manager for Windows NT and Windows 2000: Configuring PSF Direct for an
iSeries System . This publication describes how Print Services Facility (PSF Direct)
can be configured on Systems Network Architecture (SNA) networks in an
iSeries operating system.

Infoprint Manager for Windows NT and Windows 2000: Configuring PSF Direct for
the 3174 Communications Controller. This publication describes how Print Services
Facility (PSF Direct) can be configured on Systems Network Architecture (SNA)
networks in a 3174 Token-Ring gateway configuration.

Infoprint Manager for Windows NT and Windows 2000: Configuring PSF Direct for
the 3172 Communications Controller. This publication describes how Print Services
Facility (PSF Direct) can be configured on Systems Network Architecture (SNA)
networks in a 3172 Token-Ring gateway configuration.

Chapter 1. Introduction 3



* Infoprint Manager for Windows NT and Windows 2000: Configuring PSF Direct for
the 37xx Communications Controller. This publication describes how Print Services
Facility (PSF Direct) can be configured on Systems Network Architecture (SNA)
networks in either a local 37xx Token-Ring gateway configuration or remote
37xx Token-Ring gateway configuration.
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Chapter 2. Setting up Submit Express

Submit Express has the following requirements:

Windows System Requirements

Submit Express for Windows systems has these requirements:

PC with 166 MHz Pentium processor or higher

Windows 2000 Professional, Windows 2000 Server, Windows 2003 Standard, or
Windows XP Professional SP1 or later

64 MB RAM or more

10 MB hard drive space

CD-ROM drive

TCP/IP local area network (LAN) connection (Ethernet or token-ring)

Network connectivity, with a user ID having permission to submit print jobs and
perform queries

Macintosh System Requirements

Submit Express for Macintosh systems has these requirements:

PowerMac

Macintosh running OS X Version 10.1 or later
32 MB RAM

5 MB hard drive space

Local area network (LAN) connection (Ethernet)

Network connectivity with a user ID having permission to submit print jobs and
perform queries

Installing Submit Express from the Infoprint Manager Print on Demand

CD-ROM

This section contains information that you need to install Submit Express.

Installing Submit Express on a Windows system

1.

Insert the appropriate Infoprint Manager for Print-on-Demand Feature (1 of 2)
CD-ROM into the drive.

The install program will start automatically.
Select the Install Submit Express button to start the install program.

Follow the instructions as directed from the installer. The default install
directory is c:\Program Files\IBM\Infoprint Submit Express.

Installing a service update for Submit Express
To install a service update, insert the PTF CD-ROM into the drive. The install
program starts automatically.

1.
2.

© Copyright IBM Corp. 2002, 2004

Select to install Submit Express.
Follow the instructions as directed from the installer.



Notes:

a. With Infoprint Manager for AlX, you must have the Version 4.1 level of
Infoprint Submit installed for the service update to install correctly. If you
are currently using Version 3.2, first install the Version 4.1 product and then
install the service update as described above.

b. With Infoprint Manager for Windows, you must have the Version 2.1 level
of Infoprint Submit installed for the service update to install correctly.

Installing Submit Express on a Macintosh system
This section contains information that you need to install Infoprint Submit.

1. Insert the Infoprint Manager Print-on-Demand Feature CD-ROM (2 of 2) into
the drive and double-click its icon on the desktop.

2. Specify the directory where you want the install program to be unpacked.

3. Double-click the install file icon for your language to uncompress the install
program, for example, Submitinstaller_en_US.hgx.

4. Double-click the install program icon (for example, Submitinstaller_en_US) to
start installing the program.

5. Specify the directory where you want the program to be installed.
6. Follow the instructions as directed from the installer.

It is recommended that you install Submit in the Applications directory of the
Hard Drive. Once the product is installed, you can create an alias on the desktop
to provide easy access to Submit. To do this, highlight the Infoprint Submit file,
then choose Make alias from the File menu, and drag the alias onto the desktop.

Installing associated software and printer drivers

If you wish to create PostScript jobs for Infoprint Manager, you should install
printer drivers and PostScript Printer Description files (PPDs) on each of the
systems that you use for this purpose. Printer drivers are needed on the
workstations that are used to submit jobs to the Infoprint Manager server to ensure
that the correct driver is used. In addition, if you have users who are producing
PostScript files on their workstations that they want printed on the Infoprint
Manager printers, you need to load Infoprint Manager printer drivers onto these
workstations.

To install a PostScript driver, go to the Adobe Systems World Wide Web homepage
at www.adobe.com and download the correct level of PostScript driver for your
system and PostScript printing needs.

Four PPDs are provided on the Infoprint Manager Print-on-Demand Feature CD.
These PPDs support the Infoprint 60, InfoColor 70, Infoprint 4000, and Infoprint
4100 printers; they can be used on workstations that generate PostScript output.

Setting up shared file support

Infoprint Manager uses a directory or folder called ipdata for sharing files with
Submit. (With Infoprint Manager for Windows, this folder is created automatically.)

The name ipdata comes from Infoprint or IP and data for the files it will contain.
You use ipdata to provide a two-way connection between the Submit client
machine from which the job tickets have been submitted and the Infoprint
Manager server that sends them to the printer. Sharing files can save time and
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money. For example, you can have an Infoprint Manager server RIP (raster image
process) a file and save the results in ipdata. You can then reprint the ripped file
instead of re-ripping the job again.

Working with ipdata is slightly different on the Infoprint Manager Server on an
AIlX system and a Windows System:

» With Infoprint Manager for AlX, see|“Setting Up Infoprint Manager for AIX tol
use an ipdata file system’] and then see[“Configuring the Infoprint Submit cliend
for both Infoprint Manager for AlIX and Infoprint Manager for Windows” onl
page 20.|

+ With Infoprint Manager for Windows, see [“Setting up Infoprint Manager for]
Windows to use the ipdata folder” on page 19/and then see [‘Configuring the|
Infoprint Submit client for both Infoprint Manager for AlIX and Infoprint|
Manager for Windows” on page 20)

Setting Up Infoprint Manager for AIX to use an ipdata file
system

On an Infoprint Manager for AIX Version 4.1.0 system, NFS or other file sharing is
required between workstations and the Infoprint Manager server. If you plan to
connect your AIX server to Windows workstations and your Infoprint AIX server
is running AIX 4.3.3 or higher, the IBM package Fast Connect for POWER, Version
3.1, is required. Fast Connect supports a NetBIOS connection. To access current
information supporting the Fast Connect package, specify the following url in your
browser:

http://www.ibm.com/servers/aix/products/ibmsw//manage/fastconn.html

When you install the Fast Connect for POWER product on your Infoprint AlIX
server, you may receive a failure notification on fileset cifs.base.ldap 3.1.0.0, asking
you to install fileset Idap.client.rte 3.1.1.5 before proceeding. If you are using the
product to connect to Windows workstations, you can ignore this message and
proceed to [“Setting up Fast Connect for Infoprint Manager for AlX.”|

Note: If you use Netware with Submit or if you use Macintosh with Submit,
contact your IBM SE for configuration assistance or platform specific
recommendations regarding software support.

Setting up Fast Connect for Infoprint Manager for AIX
After installing AIX Fast Connect on your AlX server, you must do the following:

1. Open a dtterm window, type smit. The following screen displays.

Chapter 2. Setting up Submit Express 7
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Figure 1. SMIT entry screen

2. Select Communications Applications and Services and the following window
displays.
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Help

Figure 2. SMIT Communications Applications and Services screen

3. Select AlX Fast Connect and the following window displays.

Figure 3. AIX Fast Connect screen

4. Select Configuration and the following window displays.
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Figure 4. AIX Configuration screen

5. Select Basic Setup and the following window displays.
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Figure 5. AIX Basic Setup screen

When the Basic Setup window displays, notice that your server name appears
by default. Use the default values with the following exception:

For the Start Server field, select Now from the list.

If your configuration supports more than one domain, you must use the
WINS Address field to specify the IP address for the Windows Internet Name
service (WINS) server on the Infoprint Windows server with which you plan
to interoperate. Note that you must specify this address if you choose not to
specify the Domain Name field.

For the Domain Name field, ensure that you specify the domain name
(WORKGROUP in this example) for the group of Infoprint servers that interoperate
to provide resources as a single unit. Note that this example specifies both a
WINS Address field value and a Domain Name field value.

6. Once you have completed specifying these values, click the OK button.

7. Once successful, click Done to return to the Basic Setup menu and then click
Cancel to return to the Configuration menu for FastConnect.

8. On the Configuration menu for FastConnect, click Authentication and the
following window displays:

Chapter 2. Setting up Submit Express 11



Figure 6. AIX Authentication screen

9. Select Authentication (General), and the following window displays:

Figure 7. AIX Authentication (General) screen
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10.

11.
12.

13.

On the Authentication (General) window, use the default values with the
following exception:

For the Use Encrypted Passwords field, select Negotiate Encryption from
the list.

Once you have completed specifying the values, click the OK button.

Once successful, click Done to return to the Authentication menu and then
click Cancel to return to the Configuration menu for FastConnect.

On the Configuration menu for FastConnect, click Authentication and the
following window displays:

Syslem bAanagedmenl Inledace Toal - rocbEpan

Figure 8. AIX Authentication screen

14.

Click AIX Fast Connect and the following window displays:
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Figure 9. AIX Fast Connect screen

15. On the AIX Fast Connect screen, click Stop Server and then click Done, and
then click Start Server and then click Done to stop and start the AIX Fast
Connect server so these changes can take effect.

Configuring the Infoprint Manager for AlX Server to support
shared files

If you have installed Fast Connect and you use Submit from Microsoft Windows
workstations, you can configure Infoprint Manager on your AlX system with user
access and a shared directory that Infoprint Manager will use for saving processed
or rasterized files. Where applicable, this directory is also used when users preview
Postscript files from the Infoprint Manager Submit application.

To configure:

1. From the dtterm window, type SMIT so that the screen on the following page
displays:

Submit Express User’s Guide
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Figure 10. System Management Interface Tool Window

2. Select Infoprint Printing System, and the following screen displays:
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Figure 11. Infoprint Printing System Window

3. Select Infoprint Utilities, and the following screen displays:
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Figure 12. Infoprint Utilities Window

4. Now select Configure Fast Connect for Infoprint Manager, and the following
screen displays:
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5. Select Enable Submit Preflighting and file sharing.

An animated icon of a running man will raise his arms when the setup is
complete. Your AIX system will now have a shared directory (/ipdata) that
some Infoprint applications use for saving files and sharing data. An AIX
userid called ipuser is created with no password. If you want to set a password
for ipuser, use the SMIT panels to modify the password.

6. Now, you need to configure the Submit client (see |“Configuring the Infoprin
Submit client for both Infoprint Manager for AIX and Infoprint Manager fo

Windows” on page 20).
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Setting up Infoprint Manager for Windows to use the ipdata

folder

To work with ipdata on your Infoprint Manager Server, you need to determine the
best location for ipdata (see [“Moving the ipdata folder”) and then you need to set
it up for sharing (see |“Sharing the ipdata folder”). You can leave the ipdata folder
in its default location, or you can move it to another location.

Create a user id for ipuser

1. Navigate to the Control Panel.

2. Select Administrative Tools.

Select Computer Management.

Open the Local Users and Groups and highlight the Users folder.

With the Users folder highlighted, open the Action menu and select New
user.... The New User dialog appears

6. Enter ipuser in the User name: field, and optionally, complete the other fields
on the dialog.

7. Click Create to create ipuser.

8. Close the New User dialog, the Computer Management dialog, the
Administrative Tools dialog, and the Control Panel.

o s~ w

Moving the ipdata folder

1. Skip this procedure if you want to leave the ipdata folder in the default
location.

2. Open the Infoprint Manager Management Console.

3. Stop the Infoprint Manager Server by clicking on the Stop Server icon on the
Management Console toolbar.

4. Select Edit — Service Configuration to open the Service Configuration dialog
box. In the Paths section, change the value for Shared client path to the
desired location. For example, f:\myPODf1i1es.

5. Start the Infoprint Manager Server by clicking on the Start Server icon on the
Management Console toolbar.

Sharing the ipdata folder

Before you set up the ipdata folder for sharing, check with your system
administrator to determine the sharing policies for your location. Use the following
procedure to set up the ipdata folder so that it can be shared between Infoprint
Submit and the Infoprint Manager Server:

1. Using Windows Explorer, navigate to the ipdata folder.

2. Highlight the ipdata folder, right click on it, and select Sharing... from the
drop-down menu.

3. The Folder Properties dialog displays. On this dialog, enter ipdata as the name
for the shared folder in the entry field labeled Share this folder.

4. Click the Permissions button to open the Permissions for ipdata dialog and set
the access between your server and client machines and check the Allow box
for Full Control.

5. Click OK to enable the sharing for your folder.

6. Now, you need to configure the Submit client (see [“Configuring the Infoprint|
Submit client for both Infoprint Manager for AIX and Infoprint Manager for|
Windows” on page 20).
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Configuring the Infoprint Submit client for both Infoprint
Manager for AIX and Infoprint Manager for Windows

This section describes how to configure your Infoprint Submit Client for use with
either Infoprint Manager for AlIX or Infoprint Manager for Windows servers.

From the client system where you have installed Infoprint Submit, map a network
drive to the directory that your resources reside in.

1. Open Windows Explorer.
2. Select Tools — Map Network Drive.

3. In the Map Network Drive dialog, select a drive letter that you are not
currently using from the drop-down menu in the Drive field.

Map Metwork Drive x|

Windaws can help vou connect to a shared networlk Folder
and assign a drive letter ko the connection so that wou can

\_\ﬂ access the folder using My Computer.
..-""FF

el Specify the drive letter for the connection and the Folder
thak wou wank to conneck to;

Drive: k:

w
Folder: | Vishatneriipdatal ~|  Erowse...

Example: \\serverishare
¥ Reconnect at logon

iZonneck using a different user name.
i_reake a shorkout ko a Web Folder or FTP site,

= Back Finizh Cancel

Figure 14. Map Network Drive

4. In the Folder field, type the path \\servername\ipdata where servername is
the host name of the system where Infoprint Manager is installed.

5. Select Reconnect at logon.
6. Click the Connect using a different user name link.

7. In the Connect As dialog, type the user name ipuser and password (if
required).
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By default, wou will connect ta the netwaork, Folder as
JROOMEY Administrator, To connect as another user, enter
their user name and password below,

Lser name; IUSEr Browse, .. |

BB B
Password: I

Ik I Zancel |

Figure 15. Connect As...

8. Click OK in the Connect As dialog.
9. Click Finish in the Map Network Drive dialog.
10.

In addition, within Infoprint Submit you need to change the folders for the shared
file system. Refer to the steps below and to the following figure.

1. Start Infoprint Submit by clicking on the desktop icon.

2. Go to Options — Setup to open the Settings window.

3. Click the Folders tab to display the Folders page.

4. Specify the fully qualified path name in the Windows uses entry field.

Note: Always enter /ipdata for Server uses regardless of whether you are
using Infoprint Manager for AlX or Infoprint Manager for Windows.
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Starting Submit Express

1. Click on the Infoprint Submit Express icon that was automatically added to

the desktop after installation
is)
|

Irfoprint
Subrit
Eupress

Figure 16. IBM Infoprint Submit Express shortcut

or, on Windows, from the Start menu, go to Programs and click on Infoprint
Submit Express.

2. When you start the program the first time, the following message displays:

™ Infoprint Submit Express x|

\il_) Cannot establizh a connection to the server.
Sener settings may be incarrect or the server may be down.
Check the semer and port settings and change if needed.
Check the connection and try again.

Figure 17. Message displayed first time Infoprint Submit Express starts

3. Click OK and Infoprint Submit opens.
4. Go to the Options menu, and select Settings. The Settings dialog displays.
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QSEttings

] Preferences] Schedule] Appplicatiu:uns] Default Tiu:ket] Fnlders]

Server IP address or hame |

Part GE7d

Ok Cancel | Help | %

Figure 18. The Settings Dialog Connections Tab

5. Enter the IP address for your Infoprint Manager Server.
Let the port number default.
Select the Preferences tab.

© N o
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x|
Connections ] Schedule] Appplicatiu:uns] Default Tiu:ket] Fu:ulders]
Cecimal natation Unit=
{(* Use"" as delimiter {+ Millimeters
" Use"" as delimiter " Inches
[ Showe confirmation messages
Ok Cancel | Help ‘
Figure 19. The Settings Dialog Preferences Tab
9. Click OK to return to the main Infoprint Submit Express screen.
10. Click the Folders tab.
11. Click on the Page tab.
Prirt Page l .ﬂ.lign] Ll:u:uk] Resuurces] .&.dvanced]
Urttirmmed page size
icth FtT
Length FritT
Finizhed page size
Wickth 000 il Frifm
Lenith 000 il Frifm
Imace fit |Trim to finizhed page j
Figure 20. Settings dialog showing the Folders tab
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12. Select your preferences for Image Fit, Untrimmed page size, and Finished

page size.
Prirt FPage ] .ﬂ.lign] Lu:u:uk] Resnurces] .&.dvanced]
Uritrirnmed page size
yiclth | FritT
Lenigth ['\} | iy}
Finizshed page size
Wicth 000 i‘ Frirm
Lenigth 000 i‘ FriFm
Imace fit |Trim to finished page j

Figure 21. The Page Tab

Note: If you are working in a non-DNS environment follow these steps:

1. Find the file named HOSTS in this directory path;
CAWINNT\system32\drivers\etc.

2. Add a line in the HOSTS file, in the format

XXX XXX XXX . XXX hostname
where xxx .xxx.xxx.xxx is the IP address of the machine where the

server is running and hostname is the name of the machine where the
server is running.
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Chapter 3. Using Submit Express to process a job

Submit Express is used through the life cycle of a job. A print shop uses Submit
Express on a Windows workstation to create a job ticket for the job, submit the job
to the Infoprint Manager server for printing, and track the job.

Job tickets

An Infoprint job consists of a job ticket and all the files associated with that job. A
job ticket contains all the specifications for a job. The job ticket refers to the
customer’s job data and resources and pulls them together in a job bundle. You can
create a job ticket by using Submit Express.

You can print any part of the data by submitting a print job.

Migrating job tickets from previous versions of Infoprint Submit for

Windows
To migrate job tickets from a version of Infoprint Submit on Windows to the
current version of Submit Express, do the following:

1. From the previous version of Infoprint Submit, open the job ticket you want to
migrate.

2. Submit the job using the Hold option:
a. Open the Ticket menu and select Submit Job to submit the job.
b. Select the Schedule tab from the Submit dialog.
c. Select Hold from the RIP options group box.
d. Click OK to submit the job.
3. Select Options » Job Status to open the Job Status dialog.
4. Do the following to copy the contents of the job ticket file to a text file:
a. Select the ticket you want to migrate.
b. Click the View Ticket button to open the Job Ticket window.
c. Highlight the entire contents of the job ticket file.
d

. Copy the contents of the job ticket file to the clipboard. (For Windows
systems, press Ctrl+C.)

Open a new file in a text editor.

f. Paste the job ticket file contents into this new file. (For Windows systems,
press Ctrl+V.)

g. Save the file. (Be sure this file has an extension of .jtk.)

5. Transfer all source files listed in your job ticket file, and the converted job ticket
file, to the system that has the version of Submit Express. Save them in a
directory where they can be easily located.

6. In your version of Submit Express, select Ticket »+ Open to open the job ticket
that you created with the previous level of Submit. A dialog will open, asking
you to select the language that was used to create the job ticket file. Choose a
language from the drop-down list. When you select OK, the job ticket will be
converted to the new format and will be opened.

@
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Note: An error may occur the first time you assign a source file to the migrated

job ticket if the path to the file has changed. Use the Browse function to
locate the file, and Submit Express will save the new location information.

Important notes about migrating job tickets:

1.

In previous versions of Submit, job tickets were language-dependent, that is,
you had to use the same language in Submit as the language your job tickets
were created in. With Submit Express, the job tickets you create are
language-independent, so you can transfer job tickets among sites using other
languages.

In order to open job ticket files that were created in Japanese or Chinese, you
must have installed Submit Express on the Japanese or Chinese system;
otherwise, some characters will not display correctly.

At migration, the values are imported from the old job ticket as they existed in
the old .jtk file, even if those values violate some constraints among related
fields, as listed below. The first time you access the newly migrated job ticket
and you change any field from the set of related fields, associated values will
be recalculated according to the existing constraints from the current version of
Submit. Job ticket related fields are:

» Layout

+ Sides

* Untrimmed page size

* Finished page size

* Front side (vertical and horizontal)
» Back side (vertical and horizontal)

Untrimmed page size values are not saved in the .jtk file in any previous
version of Submit, so they will always be calculated depending on the paper
and available dimensions defined on the server for the appropriate paper.

Working with print jobs

28

When using Submit Express to create the job ticket, you will identify and organize
the printable files and other resources that make up the job. Processing a job ticket
includes these steps:

1.
2.
3.

4.

5.
6.

Creating a new job ticket
Adding files, sheets, and documents to the job ticket

Selecting the layout of the job, the desired server and printer, and other
attributes of the job

Setting print options, such as saving the RIP file or holding the job at the
printer

Submitting the job
Tracking the job by displaying messages

Creating files for printing

You generate the printable files that you submit to Infoprint Manager, file by file,
from the application that you use for authoring. For example, you can use the
Adobe PostScript driver and IBM Infoprint PostScript Printer Description files
(PPDs) to convert files to PostScript. Or, you can use Infoprint Scan to create
printable files from hardcopy.
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Note: Infoprint Scan is Programming Request for Price Quotation (PRPQ)
5799-GTG.

Creating a job ticket

Once you have installed the Submit Express application, you can begin creating job
tickets that support the orders you receive from customers.

When you create a job ticket, at a minimum you must provide the following
information:

* The server to connect to

» At least one selected item for a document

» A selected printer in the Printer field of the Print page

Describing your job

Using an Submit Express Job Ticket window, you can describe your job. The
description can include a job name, an ID, a specific description of the job, the
customer name, and other information that will assist you as you refer to the job
ticket.

To begin working on a new ticket, you start Submit Express. The Job Ticket
window displays.

[Figure 22 on page 30| shows an Submit Express job ticket.
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o= alE ez 8lex

Figure 22. An example of an Submit Express job ticket

As you create the job ticket, use the Help menu from the Job Ticket window or the
Help button on the dialogs to guide you.

You can create a new job ticket using the Ticket » New option on the Menu bar, or
you can open a previously created job ticket using the Ticket »+ Open option on the
Menu bar.

You can use the Ticket » Submit option on the Menu bar to print the job or
portion of the job as shown in the tree view of the ticket. (If you want to print just
the ticket itself, open the job ticket using a text editor and then select Print.)

|Figure 23 on page 3]1 shows the Ticket menu, which contains general tasks that
you can perform as you work with job tickets.
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Fl Infoprint Submit J¢

QG Edit Itern  Optio

[ et Crl+M
open... Ctrl+0
Closge

Save As.C

submitdoh... Ctrl+F

Figure 23. Submit Express job ticket menu

Specifying how you want the job to print

You can describe the layout of your document and specify alignment values. You

can use the fields on the Page tab to adjust the untrimmed and finished page size
for a file or document. If the image is smaller than the page, you use the fields on
the Align tab to adjust the position of the image on the page.

shows the Page tab.

—Lintrimmed page size

Width 0.00 FrT

Length 0.00 mim

~—Finizhed page size

Wigith po0 = mm
Length 0.00 :I mim
Image fit |Trimtn:| finished page ;I

Figure 24. The Page tab
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Figure 25|shows the Align tab.

[ Adjust ke

poo
poo
oo 2
oo =

Figure 25. The Align tab

Working with files in a job ticket

You build job tickets by adding documents, files and sheets, that refer to the files
that you are printing. You add these items to the job ticket using the selections
from the Item menu. The files you choose may be printable text files or graphic
files. Graphic files may include printable files that were created from hard copy by
using Infoprint Scan. Files may reside on your hard disk or in a shared directory
on another system.

[Figure 26 on page 33| shows the Select Files window that displays when you
choose to add a file to the job ticket. After you add one or more files to the job
ticket, the Files tab becomes available on the job ticket dialog.
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Figure 26. The Select Files window

Once you have added files and one or more documents to a job ticket, you can
choose whether or not to print the documents and files by checking or unchecking
the boxes that are displayed in the tree view of the job ticket. In [Figure 27 on page]
Document 1 contains a sheet that will not be printed, but all files in Documents
2 and 3 will be printed.
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Figure 27. The tree view, showing files to be printed

Scheduling your job and setting options

[Figure 28 on page 35/ shows the Schedule tab on the Settings dialog, where you
indicate how you want your job to be processed. Because the time it takes to print
a job includes both the processing (RIPing) and the actual printing, you may want
to control these activities separately to optimize the flow of paper through your
printers. You may want your job to be held in the print queue before being RIPed
and printed. You may want to RIP it now, but print it later. You can specify how
long you would like your job to be retained on the server so that it can be printed
again.
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Figure 28. The Schedule tab

Submitting a print job

When you select Submit Job from the Ticket menu, the active job ticket is sent to
the server for processing. A progress dialog is shown as files are transferred to the
server. You can view the status of the job at the server by selecting Options » Job
status...

If you select Print in the RIP Options box on the Schedule tab, the job will be
added to the print queue and will RIP and print automatically. An operator will
not have to release the job.

Saving the RIP output

The raster image processor (RIP) file is generated during the print process. Because
PostScript to RIP processing can be costly, you may want to save your RIP files for
re-printing jobs to avoid having to RIP them again.

When you add a file to your job ticket, click the Save RIPed file check box option
on the Advanced tab to specify that the RIPed file is to be saved. The RIP file is
saved in the /var/pd/<servername> directory.

Note: If you save your RIPed files, you must manually remove them from the
server.

Verifying that PostScript jobs are ready to print

If your Infoprint server receives a PostScript job from a personal computer system,
you must ensure that the Type 1 fonts required to print are either:
» Contained within the job (inline)
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* Available on the server

If the fonts are contained inline, you should have no problem in printing the
output. However, if the fonts are not available on the server, by default a job will
be cancelled.

36  Submit Express User’s Guide



Chapter 4. Using Submit Express to send jobs to a
continuous forms printer

This topic applies to all Infoprint continuous forms printers, such as the Infoprint
4000 and the Infoprint Color 130 Plus. It assumes that you have already created a
PSF actual destination to represent a continuous forms printer and printed a test
job. It further assumes that you have installed Submit Express, and are at least
somewhat familiar with how to use it.

Many of these procedures use the Infoprint Manager Administration GUI. If you
need additional information or assistance with the GUI, refer to the online help
system.

General configuration information

There are some settings on the Infoprint Manager server that you can consider
setting based on your print environment.

* If you will be printing multiple copies of your print jobs, set the Optimize for
Copies option on the actual destination.

1. In the Infoprint Manager Administration GUI, select the actual destination
that represents the printer.

2. Select Printer —» Change Tuning.

Note: If Change Tuning doesn’t appear on the printer menu, use
Add/Remove menu items to add it.

3. Change Optimize for Copies to yes.

Note: The default value for Optimize for Copies is yes for actual
destinations representing Infoprint 4000 and Infoprint 4100 printer
devices that are migrated from PSF for AIX or created using the basic
Infoprint administrator’s GUI available with the Infoprint Manager’s
Print-On-Demand Feature.

» If you are printing to an Infoprint Color 130 Plus and you print mostly small
jobs, increase the Maximum concurrent jobs value for the actual destination to
10. That way, up to ten jobs can be processing at the same time, which reduces
lag time between jobs and helps to eliminate clutching.

1. In the Infoprint Manager Administration GUI, select the actual destination
that represents the printer.

2. Select Printer —» Change Tuning.

Note: If Change Tuning doesn’t appear on the printer menu, use
Add/Remove menu items to add it.

3. Change Maximum concurrent jobs to 10.

Configuring media
Preparation
Before you configure any media, make a list of all of the different layout types that

jobs will use. In the list, include the page lengths, n-up specifications, job
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orientation (portrait or landscape), and any other information that you have. Give
each type of job a name. You will use this hame on the printer and in Infoprint
Manager. Images of some common layout types, along with their specifications, are
provided below to help you create your list.

Simple 1-up, with finished page size ledger

In this layout, the AFCCU form is wider than it is long. Even if you specify a
value for Page placement (X and Y shift) in Submit Express, the form definition
will override it.

Ledger

-
>»

Web direction

Figure 29. Ledger-sized document printed 1-up, landscape orientation

Table 1. Infoprint Manager and Submit Express values for Ledger-sized document printed
1-up, landscape

Option Value
Finished page (document) size 17 x 11 inches
Form size (Untrimmed page size: width and |17 x 11 inches
length)

Media size (in Infoprint Manager) 17 x 11 inches
Layout Simple 1-up
Form definition F100LAND
PDF orientation Landscape
Postscript orientation Landscape

Submit Express User’s Guide



Simple 1-up, with finished page size poster
In this layout, the AFCCU form size is longer than it is wide. If the finished
document size is smaller than 17 x 25 inches (for example, 16 x 24 inches), you

should make the finished page size equal to the document size.

Poster

Web direction

Figure 30. Poster-sized document printed 1—-up, portrait orientation

Table 2. Infoprint Manager and Submit Express values for 17 x 25 inch document printed

1-up, portrait

Option

Value

Finished page (document) size

17 x 25 inches

Form size (Untrimmed page size: width and
length)

17 x 25 inches or larger

Media size (in Infoprint Manager)

17 x 25 inches or larger

Layout Simple 1-up
Form definition blank

PDF orientation Portrait
Postscript orientation Portrait

Side-by-side copies 2—-up, with finished page size letter
In this layout, the AFCCU form is wider than it is long. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in Submit

Express.
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Letter

Web direction

Figure 31. Letter-sized document printed 2—up, portrait orientation

Table 3. Infoprint Manager and Submit Express values for letter-sized document printed

2—-up, portrait

Option

Value

Finished page (document) size

8.5 x 11 inches

Form size (Untrimmed page size: width and
length)

17 x 11 inches or larger

Media size (in Infoprint Manager)

17 x 11 inches or larger

Layout

Side by side copies 2-up

Form definition

blank

PDF orientation

Portrait

Postscript orientation

Portrait

Side-by-side copies 2—-up, with finished page size legal
In this layout, the AFCCU form is wider than it is long. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in Submit

Express.

Note: This layout looks the same as the layout for side-by-side copies 2-up with

finished page size letter. Refer to [Figure 30 on page 39 for an illustration of the

layout.
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Table 4. Infoprint Manager and Submit Express values for legal-sized document printed
2—-up, portrait

Option Value

Finished page (document) size 8.5 x 14 inches

Form size (Untrimmed page size: width and |17 x 14 inches or larger
length)

Media size (in Infoprint Manager) 17 x 14 inches or larger
Layout Side-by-side copies 2-up
Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 2—-up, with finished page size 9 x 8 inches

In this layout, the AFCCU form size is wider than it is long. Because you don’t
specify a form definition, you can use the Page placement (X and Y shift) option in
Submit Express.

9x8

Web direction

Figure 32. Nine by eight inch document printed 2—up, landscape orientation

Table 5. Infoprint Manager and Submit Express values for 9 x 8 inch document printed
2—-up, landscape

Option Value

Finished page (document) size 9 x 8 inches
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Table 5. Infoprint Manager and Submit Express values for 9 x 8 inch document printed
2—-up, landscape (continued)

Option Value

Form size (Untrimmed page size: width and |18 x 8 inches or larger
length)

Media size (in Infoprint Manager) 18 x 8 inches or larger
Layout side-by-side copies 2-up
Form definition blank

PDF orientation Landscape

Postscript orientation Landscape

Side-by-side copies 2—-up, with finished page size double-high
letter

In this layout, the AFCCU form is longer than it is wide. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in Submit
Express.

Doubble high Letter

Web direction

Figure 33. Double—high letter document printed 2—up, portrait orientation

Table 6. Infoprint Manager and Submit Express values for double—high letter-sized
document printed 2—up, portrait

Option Value

Finished page (document) size 8.5 x 22 inches
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Table 6. Infoprint Manager and Submit Express values for double—high letter-sized
document printed 2—up, portrait (continued)

Option Value

Form size (Untrimmed page size: width and |17 x 22 inches or larger
length)

Media size (in Infoprint Manager) 17 x 22 inches or larger
Layout side-by-side copies 2-up
Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 3-up, finished page size 6 x 11 inches
In this layout, the AFCCU form is wider than it is long. Because you don’t specify

a form definition, you can use the Page placement (X and Y shift) option in Submit
Express.

6 x 11

Web direction

Figure 34. Six by eleven inch document printed 3—up, portrait orientation

Table 7. Infoprint Manager and Submit Express values for 6 x 11 inch document printed
3—up, portrait

Option Value

Finished page (document) size 6 x 11 inches

Form size (Untrimmed page size: width and |18 x 11 inches or larger
length)
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Table 7. Infoprint Manager and Submit Express values for 6 x 11 inch document printed
3—up, portrait (continued)

Option Value

Media size (in Infoprint Manager) 18 x 11 inches or larger
Layout Side-by-side copies 3-up
Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 3—-up, with finished page size double-high

In this layout, the AFCCU form is longer than it is wide. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in Submit
Express.

6 x22

-
>»

Web direction

Figure 35. Six by twenty—two inch document printed 3—up, portrait orientation

Table 8. Infoprint Manager and Submit Express values for double-high document printed
3—up, portrait

Option Value

Finished page (document) size 6 x 22 inches

Form size (Untrimmed page size: width and |18 x 22 inches or larger
length)

Media size (in Infoprint Manager) 18 x 22 inches or larger
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Table 8. Infoprint Manager and Submit Express values for double-high document printed

3—up, portrait (continued)

Option Value

Layout Side-by-side copies 3-up
Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 4—-up, with finished paper size 9 x 6 inches

In this layout, the AFCCU form is wider than it is long. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in Submit

Express.

9x6

Web direction

Figure 36. Nine by six inch document printed 4—up, landscape orientation

Table 9. Infoprint Manager and Submit Express values for 9 x 6 inch document printed

4—up, landscape

Option

Value

Finished page (document) size

9 x 6 inches

Form size (Untrimmed page size: width and
length)

18 x 12 inches or larger

Media size (in Infoprint Manager)

18 x 12 inches or larger

Layout

side-by-side copies 4-up
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Table 9. Infoprint Manager and Submit Express values for 9 x 6 inch document printed
4—up, landscape (continued)

Option Value
Form definition blank
PDF orientation Landscape
Postscript orientation Landscape

Side-by-side copies 4—-up, with finished paper size letter

In this layout, the AFCCU form is longer than it is wide. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in Submit
Express.

Letter

-
>»

Web direction

Figure 37. Letter—sized document printed 4—up, portrait orientation

Table 10. Infoprint Manager and Submit Express values for letter-sized document printed

4-up

Option Value

Finished page (document) size 8.5 x 11 inches

Form size (Untrimmed page size: width and |17 x 22 inches or larger
length)

Media size (in Infoprint Manager) 17 x 22 inches or larger
Layout side-by-side copies 4-up
Form definition blank
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Table 10. Infoprint Manager and Submit Express values for letter-sized document printed

4—up (continued)

Option Value
PDF orientation Landscape
Postscript orientation Landscape

On the printer

Define snapshots on the printer for each type of job that you identified. Use the
names that you created above. If your list does not include dimensions, add them

as you create each snapshot.

Note: All Infoprint continuous forms printers round form lengths to the nearest
1/6 inch. Therefore, it is recommended that you use lengths in increments of

1/6 inch. Use|[Table 11|as a guide.

Table 11. Decimal equivalents of common fractions

Fraction of an inch Decimal equivalent
1/6 0.167

2/6 =1/3 0.333

3/6=1/2 0.5

4/6 = 2/3 0.667

5/6 0.833

In Infoprint Manager
1. Open the Infoprint Manager Administration GUI.

2. Verify that all of the menu items and details views columns that you will need
are displayed.

a. Select Options — Customize.
b. On the Printer tab, make sure the Change media check box is selected in

the Menu column and that Media ready is listed in the Details to show
box.

c. On the Job tab, make sure that the Change media and Change copies check
boxes are selected in the Menu column. Make sure that Media is listed in
the Details to show box.

3. Define the new media.
a. Select Server — Media — Create.

b. In the Create Media dialog, fill in the Name, Server, and Untrimmed width
and length (inches) fields as specified below. You can fill in the other fields
if you like, but these three are the only required fields. Refer to the online
help for additional information about the other fields.

Name One of the media types from your list.

Server The name of the Infoprint Manager server that sends jobs to your
printer.

Untrimmed width and length (inches)
Specify width and length values that are slightly shorter than the
ones you gave in the snapshot on the printer. The PostScript
transform and some printers (such as the Infoprint 4000) round off
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some values, so setting the width and length to slightly shorter
values accommodates that rounding. The values should be at least
.02 inches (1 mm) less than the values in the corresponding
snapshot.

c. Click OK.

d. Repeat step for the rest of the media types you need to define.
Set the Media allowed values for the printer.

a. Select the actual destination in the tree view of the GUI

Select Printer — Change media.

In the Change Media dialog, click the Media Allowed tab.

Add the new media types that you just defined to the Values list.

e. Remove any types that shouldn’t be allowed from the Values list.

f. Click OK.

Decide if you want to have more than one media type ready on the printer at
the same time. If you only have one type ready, only jobs that request that
media will be printed. Other jobs will wait in the queue until you change the
media type that is ready. Once you have decided, set the Media ready value to
the type or types that you want to print on.

a. Select the actual destination in the tree view of the GUI

b. Select Printer —»Change media.

c. On the Media Ready tab, type 1 for the Input bin number, then select the
Media type and Input tray for each media that you want to make ready.

d. Click OK.

a oo

Using Submit Express to send jobs

1.

o

10.

Open Submit Express and build a job ticket as usual.

2. Select Options — Refresh to update the list of media types from the server.
3.
4. Select the appropriate Printer type from the drop-down list, then select the

After all of the documents have been added, click the Print tab.

media type that you want to use from the Paper drop-down list.

Click the Layout tab.

Select the appropriate page layout (for example, side by side copies 2-up or
simple 3-up) from the Layout drop-down.

Click the Align tab.

Set the dimensions in the Finished page size box to the exact dimensions of
the pages in the job.

Note: You can set these dimensions in either inches or millimeters. Use
Options — Preferences to change the unit of measure.

The values in the Untrimmed page size box map to the partition area within

the printer’s printable area.

By default, the page placement (X and Y offset) value is Upper left, so the
document will be placed in the upper left corner of the form. If you want the
document to be positioned differently, select a different page placement value.

Submit the job as usual.

Troubleshooting

If you submit a job that requests a media type that isn’t listed as ready in the
server, the job icon will turn red. To print the job, do the following:
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1. Change the snapshot on the printer.

2. In the Infoprint Manager GUI, highlight the printer, then select Printer —
Change Media.

3. On the Media Ready tab of the Change Media dialog, change the values to the
media you want to use.

4. Click OK.

Once the Media Ready value is reset, jobs that request the changed media type
will start to print.
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Notices

This information was developed for products and services offered in the USA. IBM
may not offer the products, services or features discussed in this document in your
country. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product,
program or service is not intended to state or imply that only that IBM product,
program or service may be used. Any functionally equivalent product, program or
service that does not infringe any IBM intellectual property right may be used
instead. However, it is the user’s responsibility to evaluate and verify the operation
of any non-IBM product, program or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

500 Columbus Avenue
Thornwood, NY 10594
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS 1S” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer or express or
implied warranties in certain transactions, therefore this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the material for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one), and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Mail Drop 001W
Boulder, CO 80301
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on developmentlevel
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning nonIBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM
has not tested those products and cannot confirm the accuracy of performance,
compatibility or any other claims related to nonIBM products. Questions on the
capabilities of nonIBM products should be addressed to the suppliers of those
products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

The following are trademarks or registered trademarks of International Business
Machines Corporation:

Advanced Function Printing

AFP

AIX

AS/400

eNetwork

IBM

IBM Cross Platform Technologies for Windows

Infoprint

Intelligent Printer Data Stream

IPDS

Micro Channel
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MVS

0s/2

0S/390

0S/400

Print Services Facility
S/390

System/370

The following are trademarks of other companies:

» Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or
both.

* Microsoft, MS-DOS, Windows, Windows NT, Windows 2000, Windows ME,
Microsoft Visual Basic, Microsoft Visual C++, and the Windows logo are
trademarks of Microsoft Corporation in the United States, other countries, or
both.

* Pentium is a registered trademark of Intel Corporation in the United States,
other countries, or both.

* UNIX is a registered trademark of The Open Group in the United States and
other countries.

Other company, product, and service names may be trademarks or service marks

of others.
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